Key to

ALL ABOUT COMPUTERS

Keybooks are freely available at our website http://www.ProgressPublishers.com

PROGRESS PUBLISHERS
KRISHNA NAGAR, DELHI - 110051
EMAIL : progresspublishers@gmail.com
1. HISTORY OF COMPUTERS

1. | Computer Generation | Period       | Technology Used    |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>First Generation</td>
<td>1946 – 1958</td>
<td>Vacuum Tubes</td>
</tr>
<tr>
<td>Second Generation</td>
<td>1956 – 1963</td>
<td>Transistors</td>
</tr>
<tr>
<td>Third Generation</td>
<td>1964 – 1971</td>
<td>Integrated circuits</td>
</tr>
<tr>
<td>Fourth Generation</td>
<td>1971 – Present</td>
<td>Microprocessors</td>
</tr>
<tr>
<td>Fifth Generation</td>
<td>Present and Beyond</td>
<td>Artificial Intelligence</td>
</tr>
</tbody>
</table>

2. (a) Abacus   (b) Charles Babbage
   (c) Transistors (d) Analytical Engine
   (e) Robotics

3. (a) fourth   (b) Charles Babbage
   (c) semiconductors  (d) Fifth
   (e) Artificial Intelligence

4. (a) F   (b) T   (c) F   (d) T   (e) T

5. (a) Abacus, Napier’s bones, Pascaline calculator, Difference engine, Analytical engine, ENIAC, IBM 401, Desktop computer.
(b) The characteristics of third generation computer are :-
   1. Third generation computers used smaller sized transistors placed on silicon chips, called semiconductors.
   2. These computers used an operating system for their overall functioning.
   3. These computers started using keyboards and monitors.
(c) Charles Babbage invented the difference engine in 1822. This device was made from mechanical parts. It could perform tabular calculations. Charles Babbage also invented the analytical engine in 1833. This machine was made from steam driven mechanical parts. It could perform all arithmetic operations such as addition, subtraction, multiplication and division. It had All the main parts that any modern computer has – input device, storage device, a central processing unit, and an output device.
Calculating devices invented before the modern computer are :-

1. Abacus - It was the first mechanical calculator developed in China approximately 2600 B.C. It performed simple addition, subtraction, multiplication and division of numbers. An abacus consists of beads that can be moved on a series of sticks within a wooden frame.

2. Napier’s Bones - Napier’s Bones was invented in 1617 by Scottish Mathematician Sir John Napier. The device was used to solve complex multiplication and division calculations easily. It consisted of rods made from bones with numbers marked on them.

3. Pascaline calculator - The Pascaline calculator was developed in 1642 by a French Mathematician Blaise Pascal. It was made up of wheels, dials and gears. It could solve complex mathematical calculations involving large numbers. It is considered as the first mechanical calculator in the world.

The characteristics of fifth generation computer are :-

1. These computer can recognize speech and handwriting patterns.
2. These computer can recognize images and graphs.
3. These computer are capable of performing highly complex calculations at very high speed.

Think and Answer

(a) Fourth Generation

(b) Artificial Intelligence

2. INPUT AND OUTPUT DEVICES

1. (a) Projector (b) Light Pen
   (c) Digital camera (d) Barcode (e) Monitor
2. (a) mouse (b) hard copy (c) stylus
   (d) webcam (e) monitor
3. (a) T (b) T (c) T (d) F (e) T
4. (a) A series of input, process and output operations is called the IPO cycle.

(b) A device that combines an input and an output device in a single unit is called a Multifunction Device.

Some Multifunction Devices are :-
1. A multifunction printer combines a printer and a scanner in a single unit.
2. A digital Camera is another input/output device. It is used to capture images through its lens and display images on its screen.

(c) Some common types of printers are :-
1. Dot Matrix Printer – It prints text and images by striking pins against an ink ribbon to form closely spaced dots in the appropriate shape. It is loud, slow and prints only in black color.
2. Inkjet Printer – It sprays droplets of ink onto paper to form text and images. It can print in black as well as in color. It has better printing quality than a dot matrix printer.
3. Laser Printer – It prints graphics and text on paper by using a laser beam. The laser beam burns the ink onto the paper. It can print in black as well as color. It prints very fast and produces high quality printouts.

(d)(i) Light pen is a pen shaped input device used to draw objects directly onto the computer screen. It is also used to point at and select objects on the screen. Graphic tablet is an input device that consists of a flat surface on which the user writes and draws using a stylus. The text and drawings appear as digital images on the computer screen.

(ii) Webcam is an input device connected to a computer to capture still images and live videos. It is commonly used for videoconferencing and video chatting. A digital camera is an input/output device. It is used to capture images through its lens and displays images on its screen.
(iii) Printer is an output device which prints information displayed on a monitor onto paper. Projector is a output device used for displaying videos, images or computer data on a screen or other flat surface.

(iv) Trackball is an input device has a ball on its surface which can be rolled with fingers to move the pointer on the screen. Joystick is an input device to play games on a computer. It has buttons to control various actions in a game.

Think and answer
(a) Scanner
(b) Projector or digital camera

3. COMPUTER MEMORY

1. (a) Primary memory  (b) Cloud storage  (c) ROM  
   (d) NAS  (e) Byte
2. (a) DVD  (b) SSD  (c) Magnetic  
   (d) NAS  (e) Byte
3. (a) F  (b) T  (c) T  (d) F  (e) F
4. (a) RAM stands for ‘Random Access Memory’. It stores data and instructions used by the CPU to perform various tasks. Ram is a read/write memory. Information can be written to it and read from it at a very fast speed.
It stores information only as long as the computer is working. Once the computer is shut down, the information stored in RAM is lost. Thus, it is a volatile memory.

ROM stands for ‘Read only Memory’. The instructions in ROM are written using laser technology by the manufacturer. It cannot be changed or modified by the user, hence called, read-only. The instructions in ROM stay in ROM even when the computer is switched off. Thus, it is a non-volatile memory.

(b) Cache memory is a fast and efficient memory on which read and write operations can be done faster than RAM. Cache memory usually stores the data and instructions used more frequently by the CPU. It acts as a buffer between the CPU and the RAM.

(c) Secondary storage devices are used to store information that needs to be accessed frequently. Three secondary storage devices that are not fixed inside the CPU are: Pen drive, memory card and DVD.

(d) Primary memory is in the form of memory chips that are attached to the motherboard of the computer or are built into it. It has limited capacity to store data. It is directly accessible by the CPU. The CPU reads the instructions stored in the primary memory continuously, and executes them as and when required. Secondary memory allows permanent storage of large quantities of data (not directly accessible by the CPU). The capacity of secondary memory is high, usually measured in gigabytes or terabytes.

(e) 1. Programmable Read Only Memory
2. Electrically Erasable Programmable Read Only Memory
3. Network Access Storage
4. Solid State Disk

Think and answer

(a) Memory Card
(b) Portable hard disk
4. CUSTOMISING WINDOWS 10

1. (a) Icons  (b) Wallpaper  
   (c) Lock screen  (d) Rectangle  (e) \[\text{icon}\]

2. (a) burning out  (b) Desktop  
   (c) Start menu  (d) Live tiles  (e) Screen saver

3. (a) F  (b) T  (c) T  (d) F  (e) T

4. (a) steps to set an image as Desktop Background are:
   1. Click the start button on the taskbar.
      The start menu appears.
   2. Click the settings icon.
      The settings app window opens.
   3. Click personalization.
      The personalization settings appear.
   4. Click the drop down list under Background and choose Picture.
   5. Click one from the recent images under choose your picture or click browse and select a picture for the background.
   6. Click the drop down list under choose a fit and select a fit style – Fill, Fit, Stretch, Centre, Tile, or span – for the picture.
   7. Click the x button to close the settings app window.
      The selected background is displayed on the desktop.
(b) To set the screen saver:
1. Click the start button to display the start menu.
2. Click the settings icon,
The settings app window opens.
3. Click personalization.
The personalization settings appear.
4. Click Lock screen.
5. Scroll down and click the Screen saver settings. The screen saver settings dialog box opens.
6. Click the drop down list under screen saver and choose a screen saver. A preview of the screen saver is displayed in the dialog box.
7. In the wait box, specify the minutes for which the computer should remain idle before the screen saver is displayed.
8. Click the OK button.
9. Click the x button to close the Settings app window.
The selected screen saver appears on the monitor, when the computer is left idle for the specified time.

(c) To change the background of the Lock screen:
1. Click the start button to display the Start menu.
2. Click the settings icon, the setting app windows opens.
3. Click personalization, the personalization settings appear.
4. Click Lock screen.
5. Click the drop down list under Background and click Picture.
6. Click one from the recent images under choose your picture or click browse and select a picture for the lock screen.
7. Click the x button to close the setting app window.
The selected image will appear when you lock or start your computer.

(d) Live tiles display constantly changing information from the computer or the Internet.
To turn a Live tile On/Off:
1. Click the start button to display the start menu.
2. Right click the Live tile you want to turn On/Off.
3. Click more and select Turn live tile Off or Turn live tile On.
   The behaviour of the tile is changed.

(e) We customize the appearance of icons on the desktop to keep the desktop organized.

5. FILES AND FOLDERS

1. (a) Subfolder   (b) ↑
   (c) Navigation Pane   (d) File explorer
   (e) Ctrl

2. (a) folder     (b) file icon     (c) subfolder
   (d) address bar   (e) Recycle bin

3. (a) F   (b) T   (c) T   (d) F   (e) T

4. (a) A filename extension is a set of characters added to the end of the filename. It helps windows to understand what kind of information is in a file and which program will open it. File extension for Word 2016 is .docx and PowerPoint 2016 is .pptx
   (b) A file is a collection of data that has been created, named and stored on a hard disk of a computer or an external storage media while a folder is a container that helps to organize the files. Every file on a computer is stored in a folder.
   (c) File explorer is a program that enables you to work with files and folders on your computer. It helps you to view, create, copy, move, rename and delete files and folders. The various parts of the File explorer windows are:
   Title Bar, Quick Access toolbar, Ribbon, Address Bar, Search box, Navigation pane, Navigation buttons, Contents pane and status bar.
   (d) To copy a file at another location:
      1. Open the location that contains the file you want to copy.
2. Click the file you want to copy.
3. On the home tab, in the clipboard group, click copy. Windows places a copy of the file in the clipboard.
4. Open the location where you want to copy the selected file.
5. On the Home tab, in the clipboard group, click paste. A copy of the original file appears in the new location.

(e) To rename a folder:
1. In the contents pane, click the folder you want to rename.
2. On the home tab, in the organize group, click rename. A text box appears around the folder name.
3. Type the new name and press enter. The folder is renamed.

Think and answer
(a) Restore deleted documents from the Recycle Bin on the Desktop.
(b) To move a file/folder:
   1. Open the location that contains the file/folder you want to move.
   2. Click the file/folder you want to move.
   3. On the Home tab, in the Clipboard group, click Cut. Windows places the file/folder in the clipboard.
   4. Open the location where you want to move the selected file/folder.
   5. On the Home tab, in the Clipboard group, click Paste. The file/folder appears in the new location.

6. MORE LOGO COMMANDS

1. (a) Main screen (b) HT
   (c) PENDOWN (d) SETPENCOLOR 4
2. (a) BK 50 (b) PENNORMAL
   (c) SHOWTURTLE (d) Main screen
3. (a) T (b) F (c) T (d) F
4. (a) The LOGO commands are used to move the turtle around the screen, draw lines, display text, or change its behaviour.

(b) The PENUP command lifts the pen of the turtle up from the Main screen while HIDETURTLE command hides the turtle from the main screen.

(c) The PENPAINT command sets the pen of the turtle from erase mode to drawing mode. While PENNORMAL command resets the turtle to its default pen color, pen size and sets the turtle to drawing mode.

(d) 1. CS command clears the Main screen and brings the turtle back to HOME position.
   2. PD command puts the pen of the turtle down on the main screen.
   3. SETH command turns the turtle right by n degrees from its HOME position.
   4. PE command sets the pen of the turtle to the erase mode. This command is used to erase a line by moving the turtle over it.

**Practical Assessment**

<table>
<thead>
<tr>
<th>Command</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>LT 90</td>
<td></td>
</tr>
<tr>
<td>FD 100</td>
<td>PD 25</td>
</tr>
<tr>
<td>RT 120</td>
<td>FD 50</td>
</tr>
<tr>
<td>FD 100</td>
<td>RT 90</td>
</tr>
<tr>
<td>RT 120</td>
<td>FD 25</td>
</tr>
<tr>
<td>FD 100</td>
<td>RT 90</td>
</tr>
<tr>
<td>RT 30</td>
<td>FD 50</td>
</tr>
<tr>
<td>FD 100</td>
<td>RT 90</td>
</tr>
<tr>
<td>RT 90</td>
<td>FD 25</td>
</tr>
<tr>
<td>FD 100</td>
<td>PU</td>
</tr>
<tr>
<td>RT 90</td>
<td>BK 80</td>
</tr>
<tr>
<td>FD 100</td>
<td>RT 90</td>
</tr>
<tr>
<td>BK 20</td>
<td>FD 10</td>
</tr>
<tr>
<td>RT 90</td>
<td>LT 90</td>
</tr>
<tr>
<td>PU</td>
<td>PD</td>
</tr>
</tbody>
</table>
FD 40
RT 90
FD 30
RT 90
FD 40

(b) SETPENSIZE [5 5]
SETPENCOLOR 10
FD 100
RT 90
FD 100
RT 90
FD 100
RT 90
FD 100
RT 90
PU
FD 10
RT 90
FD 10
LT 90
PD
SETPENCOLOR 4
FD 80
RT 90
FD 80
RT 90
FD 80
RT 90
FD 80

(c) RT 90
FD 140
7. TURTLE – MAKING SHAPES

1. (a) Square brackets (b) 72 times
   (c) Hexagon (d) 5 units

2. (a) 360 (b) 50
   (c) inner, outer (d) 45

3. (a) T (b) F (c) T (d) F

4. (a) To draw a polygon using REPEAT command values required are number of sides, and number of units.
   (b) 360 degrees/number of sides
   (c) REPEAT (number of sides) and RT
   (d) 1. REPEAT 5 [FD 40 RT 72]
      2. REPEAT 270 [FD 4 RT 1]
      3. REPEAT 180 [FD 2 RT 1]

5. (a) REPEAT 8 [FD 80 RT 45]
   (b) REPEAT 4 [FD 120 RT 90]
      RT 90
      FD 120
      REPEAT 3[FD 80 LT 90]

Practical Assessment
   (a) REPEAT 180 [FD 5 RT 2]
      REPEAT 180 [FD 4 RT 2]
      REPEAT 180 [FD 3 RT 2]

   (b) REPEAT 5 [FD 100 RT 72]
      REPEAT 4 [FD 100 RT 90]
      REPEAT 3 [FD 100 RT 120]

   (c) REPEAT 4 [REPEAT 180 [FD 5 RT 2] LT 90]
8. WORD – EDITING TEXT

1. (a) Selection Bar (b) Cut and paste  
   (c) Review tab (d) blue wavy line (e) Change All  
2. (a) thrice  
   (b) Ctrl +A (c) Thesaurus (d) last (e) dictionary  
3. (a) T (b) F (c) T (d) T (e) T  
4. (a) | Text to Select | Mouse action |
    | One word | Double click the word |
    | Block of text | Click and drag over the required text |
    | One sentence | Press Ctrl key and click a word in the sentence |
    | One paragraph | Triple click anywhere inside the paragraph |
(b) Word 2016 has an inbuilt dictionary to check the spelling of the text in a document. Various options available to correct it are:
   1. To correct the error, select an option and click on change button.  
   2. To correct all occurrences of the error, select an option and click on change all button.  
   3. To ignore the error once, click on Ignore button.  
   4. To ignore all occurrences of the error, click on ignore all button.  
   5. Word may identify the correct word as incorrect because it may not be present in its dictionary. You can add the word to the dictionary by clicking the add button in the spelling pane.  
(c) Undo command is used to reverse the last action or a series of recent actions. Redo command is used to cancel the actions reversed by the undo command.  
(d) Copying text creates a duplicate copy of the selected text without affecting the original text. While moving text removes the selected text from its original location.

(e) | Text to Select | Mouse action |
    | A line of text | Click in the Selection bar to the left of the line |
    | A paragraph | Double click in the Selection bar to the left of the paragraph |
    | Multiple lines | Click and drag in the Selection bar |
    | Entire document | Triple click in the Selection bar |
(f) Making changes to the text in a document is called editing of text. It involves adding text, deleting text, copying and moving text, and checking spelling and grammatical mistakes in the text.

Think and answer

Thesaurus

9. FORMATTING TEXT IN WORD

1. (a)  
   (b) **Capitalise Each Word**
   (c)  
   (d) **Minibar**
   (e)  

2. (a) highlighted  
   (b) **Bulleted**
   (c) **Center**  
   (d) **Ctrl + B**
   (e) **Font**

3. (a) T  
   (b) T  
   (c) T  
   (d) F
   (e) F

4. (a) Formatting refers to change in the appearance and arrangement of text in a document. It makes the text in a document impressive and legible.

   Changing appearance of text involves changing the properties of characters – typeface, size, colour, style, or case.

   Changing arrangement of text involves alignment of text, enclosing it within borders or applying shading on it.

   (b) 1. **Sentence case** : It changes the first letter of each sentence to uppercase and all other letters to lowercase.

       2. **Lowercase** : It changes the case of selected text to lowercase.

       3. **UPPERCASE** : It changes the of selected text to uppercase.

       4. **Capitalise Each Word** : It changes the first letter of every word in the selected text to uppercase.

       5. **tOGGLE cASE** : It changes the uppercase letters to lowercase and vice versa.

   (c) To create a number list in a document :-

       • Place the cursor where you want to start the list.

       • On the home tab, in the paragraph group, click the down arrow next to numbering option for a numbered list.
A list of different number styles appears.
• Click the desired style.
Word insert a number to start the list.
• Type an item in the list and press enter key to add the next item.
• To end the list, press enter twice after the last item.

(d) To apply border effect to text:
• Select the text to apply border.
• On the home tab, in the paragraph group, click the down arrow next to border button.
A list of options appears.
• Click borders and shading.
The border and shading dialog box appears.
• Click the border tab.
• Select the type of border from the setting option.
• Select the style for the border from the style list box.
• Select the colour for the border from the Color list box.
• Select the thickness for the border from the Width list box.
The Preview box displays how the border will appear in the document.
• Click OK to apply the selected border.

(e) Alignment is the manner in which text is placed between the left and right margins of a page. Various alignments available are in word are :-
• Align left – It aligns the text with the left margin.
• Center – It aligns the text in the center of left and right margins.
• Align right – It aligns the text with the right margin.
• Justify – It aligns the text with both the left and right margins.

Think and answer
(a) Numbered List
(b) Font, font size, font colour & font style.
10. INTRODUCTION TO POWERPOINT 2016

1. (a) Normal view  b) .pptx  
   (c) Reading view  (d) Esc  (e) Start screen

2. (a) Slide sorter  (b) Status bar  
   (c) placeholders  (d) presentation  (e) F5

3. (a) F  (b) F  (c) F  (d) F  (e) T

4. (a) PowerPoint is a presentation software. It provides the user various tools to build attractive presentations. Some features of powerpoint 2016 are :-

   PowerPoint enables us to:
   • Create visually attractive presentation with text, pictures and diagrams.
   • Edit contents of a slide easily.
   • Apply various formatting to text in a slide.
   • Apply themes to enhance appearance of slides.
   • Add audio or video files to slides.

(b) Slide is a page in the presentation.

   To add a new slide to presentation:-
   1. Click the slide in the thumbnails pane after which you want to add the new slide.
   2. On the home tab, in the slides group, click the new slide down arrow.
      A list of slide layout appears.
   3. Click the desired slide layout from the list.
      A new slide with the selected layout is inserted after the selected slide.

(c) Some views available in the Powerpoint 2016 are :-
   1. Slide sorter view – The slide sorter view displays all the slides of a presentation in form of thumbnails. This view lets you rearrange slides, group them in sections and apply backgrounds to slides.
   2. Notes page view – The notes page view enables one to create speaker notes that can contain elements other than text and to add tables, diagrams or charts to the notes.
3. Reading View – The Reading View previews the slide show of the presentation without switching to full screen mode. It helps the user to fine tune the slide show and view all animation and transition effects.

(d) To apply a theme to the presentation:
   • Click the Design tab on the ribbon.  
The Themes group displays various themes.
   • Move the mouse pointer over a theme.
     A preview of the theme is displayed on the slide.
   • Click a theme to apply it.
     The selected theme gets applied to the presentation.

(e) A slide show displays a presentation in form of slides in full screen. During a slide show, slides are displayed on the screen in a sequence, one by one. To start a slide show:
   • On the Slide Show tab, in the Start Slide Show group, click:
     From Beginning: to start the slide show from the first slide.
     From Current Slide: to start the slide show from the present slide.
     PowerPoint switches to slide show mode and displays the slide.
   • Click anywhere in the slide to view the next slide or click the Next navigation button.
   • Click the previous navigation button to go back to the previous slide.
   • When the slide show ends, click anywhere on the screen to exit slide show mode.

Think and answer
(a) Slide Sorter View

11. INTERNET

1. (a) Search engine  (b) Search engine
   (c) World Wide Web  (d) an email address
2. (a) website     (b) URL
   (c) modem      (d) hyperlink   (e) search engine
3. (a) T        (b) T        (c) F    (d) F    (e) T
4. (a) An E-mail or electric mail is a message sent from one computer to the another through Internet. It may contain text, graphics, audio, video or other files as attachments. An email is delivered instantly and eliminates barriers of time and distance. To send or receive an email over Internet, you need an email account.

(b) An Internet Service Provider is a company that provides an Internet connection to its customers. It also provides hardware devices such as modem to connect to the Internet.

5. (a) A network is a group of two or more interconnected computers that enables you to share information stored in them. We need it to share the information with other users.

(b) The essential requirements to connect to the Internet are:
   • A computer
   • An Internet Service Provider
   • A modem
   • A telephone line or cable connection
   • A Web browser.

(c) Internet stands for International network. It is a worldwide network of computers that connects millions of computers together. It is the global storehouse for information which enables a user to access information and communicate with others.

Three uses of Internet are :-
   • One can search information on any topic on the Internet.
   • One can communicate with others through email or video conferencing on the Internet.
   • One can play games, listen to music and watch videos on the Internet.

(d) A search engine is a web based tool that enables you to search for a particular information found in the World
Wide Web. A search engine maintains an index of web pages on the basis of keywords and tags. Some popular search engine are Google Search and yahoo search.

(e) (i) Internet Service Provider
(ii) Uniform Resource Locator
(iii) World Wide Web

Think and answer

(a) A computer, modem, Internet connection, web browser and email address.
(b) Contact the Internet Service provider.

1. (a) Transistor  
(b) Cloud storage  
(c) Navigation pane  
(d) Renaming the tile  
(e) Scanner

2. (a) Charles Babbage  
(b) Inkjet printer  
(c) TB  
(d) Live tiles  
(e) extension

3. (a) T  
(b) F  
(c) T  
(d) F  
(e) T

5. (a) Desktop  
(b) Barcode  
(c) Microprocessors  
(d) Projector  
(e) NAS

6. (a) Primary memory is in the form of memory chips that are attached to the motherboard of the computer or are built into it. It has limited capacity to store data.
It is directly accessible by the CPU. The CPU reads the instructions stored in the primary memory continuously, and executes them as and when required. We need secondary memory because it allows us permanent storage of large quantities of data.

(b) The fourth generation computers:
- have thousands of integrated circuits built onto a single silicon chip.
- are more powerful and versatile.
- support high level programming languages.

(c) 1. Monitor - Monitor displays various programs running on the computer.
2. Printer - Printer prints information displayed on a monitor onto paper.
3. Speakers - Speakers are used to listen to audio output from the computer.

(d) A screen saver is a program which displays moving patterns or animated images on the screen after a period of inactivity. It is required to prevent screen from burning out due to same image being displayed for a long time.

(e) To copy a file from one folder to another.
1. Open the location that contains the file you want to copy.
2. Click the file you want to copy.
3. On the Home tab, in the Clipboard group, click Copy. Windows places a copy of the file in the clipboard.
4. Open the location where you want to copy the selected file.
5. On the Home tab, in the Clipboard group, click Paste. A copy of the original file appears in the new location.

**ASSESSMENT SHEET – 2**

1. (a) PU  (b) URL  (c) Thesaurus  
   (d) Slide Sorter View  (e) 360/n
2. (a) Hyperlink  (b) numbered  
   (c) web browser     (d) .pptx      (e) F7
3. (a) T     (b) F     (c) T     (d) T     (e) F
4. (a) Home page  b) Reading view  
   (c) Paragraph group  (d) Minibar     (e) Modem
5. (a) SETPENCOLOR 4
     REPEAT 4 [REPEAT 4 [FD 100 RT 90] RT 90  
     HT
     (b) REPEAT 2 [FD 50 RT 90 FD 50 RT 90]  
     PU
     FD 10
     RT 90
     FD 10
     LT 90
     PD
     REPEAT 2 [FD 30 RT 90 FD 80 RT 90]  
     HT
6. (a) The HD (HIDETURTLE) command hides the turtle while  
     PU (PENUP) command lifts the pen of the turtle up  
     from the Main screen.
   (b) Editing text refers to making changes to the text in  
     a document. It involves adding text, deleting text,  
     copying and moving text, and checking spelling and  
     grammatical mistakes in the text.
     Formatting text refers to change in the appearance and  
     arrangement of text in a document. It involves size,  
     color, style or case and alignment of text borders,  
     shading, etc.
   (c) The Normal view allows you to create and design a pres-  
     entation. This view lets you work on the contents of  
     the individual slide. It allows you to navigate between  
     slides and to rearrange, add or delete slides from a  
     presentation.
The Slide Sorter view displays all the slides of a presentation in form of thumbnails. This view lets you rearrange slides, group them in sections and apply backgrounds to slides.

7. (a) Selection bar is the space between the left edge of the pane and the left text margin.

The ways to select various parts of text using the selection bar are:

1. A line of text - Click in the Selection bar to the left of the line.
2. A paragraph - Double click in the selection bar to the left of the paragraph.
3. Multiple lines - Click and drag in the selection bar.

(b) Alignment is the manner in which text is placed between the left and right margins of a page.

Various alignments available in Word are:

Align left – It aligns text with the left margin.
Center – It aligns text in the center of left and right margins.
Align right – It aligns text with the right margin.
Justify – It aligns text with both the left and right margins.

(c) A presentation is a systematic display of information on a particular topic. It is made up of one or more pages called Slides.

To apply theme to the presentation:

• Click the Design tab on the ribbon.
  The Themes group displays various themes.
• Move the mouse pointer over a theme.
  A preview of the theme is displayed on the slide.
  Click a theme to apply it.
  The selected theme gets applied to the presentation.
(d) The requirements for accessing a web page on the Internet are:

1. Computer  
2. Internet connection  
3. Web browser  
4. Address of webpage

(e) A search engine is a web-based tool that enables you to search for a particular information found in the world wide web. A search engine maintains an index of web pages on the basis of keywords and tags. Some popular search engines are google search, yahoo search and bing. To search for information for a topic, you need to enter keywords or phrases in the search engine. The search engine searches the required information and displays the result in the form of images, text or hyperlinks.

---

**CYBER BYTES**

1. RAM  
2. 1 GB  
3. Charles Babbage  
4.  
5. Lock the computer  
6. PD  
7. Red  
8. Capitalize Each Word  
9. Copy/cut  
10. Hyperlink  
11. 5/12  
12. 16  
13. 18  
14. ἘΝΙΧΙΦ  
15. 44  
16. 25  
17. Multiply by 1, then multiply by 2 then multiply by 3 and so on............

18. 

19. POEAR  

20. 

24